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ESTUARY LESSON PLAN

Eyes on the Estuaries

Focus
Monitoring Living Resources in Estuaries

Grade Level
9-12

Focus Question 
How can we monitor and compare living resources in U.S. 
estuaries?

Learning Objectives 
• Students will retrieve and interpret data on the distribution 

of selected estuarine animals at various stages in the life his-
tory of these animals and relate these distributions to salinity 
conditions.

• Students will compare the distribution of selected species in 
two or more estuaries, and to draw inferences about the ecol-
ogy of these estuaries.

Materials Needed 
• copies of “ELMR Database Worksheet,” one copy for each 

student group
• (optional) Computers with internet access; if students do 

not have access to the internet, download copies of materials 
cited under “Learning Procedure” and provide copies of these 
materials to each student or student group

• a spreadsheet program such as Microsoft Excel®

Audio/Visual Materials Needed 
None

Teaching Time 
One or two 45-minute class periods, plus time for student 
research
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Seating Arrangement 
Groups of 3 - 4 students 

Maximum Number of Students 
30

Key Words
Estuary
 

Background Information 
Coastal ecosystems provide many benefits to human com-
munities, including food, ports, recreational opportunities, 
habitats for diverse plant and animal life, and minerals. More 
than half of the U.S. population lives near a coast, and about 
one of every six jobs in the U.S. is related to coastal or marine 
resources. Because these systems are vulnerable to stress from 
natural processes and human activity, the National Ocean 
Service (NOS) has a variety of programs designed to protect 
coastal resources and the opportunities they provide. Two of 
the basic requirements for providing this protection are:

• The ability to recognize change in coastal resources; and 
• The ability to distinguish normal variations from changes 

that may signal significant problems. 
Coastal monitoring programs provide the information needed 
to recognize and interpret changes in coastal resources.

“Coastal monitoring” refers to periodic measurements of 
physical, chemical, biological, and meteorological factors 
that may affect the use and quality of coastal resources. For 
example, such factors may include temperature, salinity, pres-
ence of chemical contaminants, biological species, life stages 
of these species (eggs, juveniles, adults, etc.), rainfall, and 
storm events. NOS supports 28 different monitoring systems 
to provide key pieces of information needed to protect marine 
resources and control the ways in which they are used. These 
programs fall into four classes that represent different geo-
graphic scales. 

The first class includes measurements of environmental fea-
tures over large geographic areas using sensors or instruments 
on airplanes, satellites, and ships. These features include dis-
tribution of habitat types or land cover, algal blooms, water 
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depth, shoreline location, and land topography. 
The second class includes physical, chemical, biological, and 
meteorological measurements at specific sites. These measure-
ments are made periodically and are usually intended to pro-
vide information on specific resources or environmental stress-
es. Measurements include currents, water quality and weather 
in 26 National Estuarine Research Reserves, contaminants in 
sediments and bivalve molluscs at 250 sites, and water level 
measurements used to predict tides.

The third class includes intensive and frequent measurements 
of environmental conditions at a few locations of particular 
importance. These include coral reef ecosystems, 13 National 
Marine Sanctuaries, sites where there is a high potential for 
substantial environmental degradation (Narragansett Bay, 
Chesapeake Bay, and San Francisco Bay are among more than 
280 sites being monitored) and real-time measurements of 
water levels, currents, and other oceanographic conditions 
in 10 U.S. ports including New York/New Jersey Harbor, 
Houston/Galveston Bay, Los Angeles/Long Beach, and the Port 
of Anchorage.

The fourth class includes monitoring activities that are 
focussed on a single physical location, ecosystem, or oil 
spill sites. The Everglades, Chesapeake Bay, and the M/V 
Selendang Ayu oil spill site in Alaska are among the areas 
included in this part of the NOS monitoring program.

This activity focuses on information contained in the NOS 
Estuarine Living Marine Resources (ELMR) Database. The 
ELMR Program was established to develop baseline informa-
tion on ecologically and economically important fishes and 
invertebrates in U.S. estuaries. The database includes informa-
tion on the distribution, relative abundance, and life history 
characteristics of 153 species found in 122 estuaries and coastal 
embayments on the Pacific, Atlantic, and Gulf of Mexico coasts. 
In this lesson, students will use the ELMR Database to com-
pare characteristics of selected species in two or more estuaries, 
and to draw inferences about the ecology of these estuaries.
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Learning Procedure 
1. 
Decide which estuaries and which species within these estuar-
ies will be assigned to each student group. If the same estuar-
ies and species are assigned to each group, it will be easier for 
students to compare their results with those of other groups. 
On the other hand, assigning each group a different set of 
estuaries and species will provide greater variety, as well as 
ensure that each group does their own work; but this will also 
require more advance preparation by the teacher. 

The key consideration is that the assigned species must be 
present in both assigned estuaries to permit comparison 
between the two sites. If the assigned estuaries are from differ-
ent regions (Mid-Atlantic, South Atlantic, etc.) there is greater 
likelihood that there will be noticeable differences in the eco-
logical characteristics of at least some of the species found in 
both locations. The best way to make these decisions is to visit 
the ELMR Database at http://biogeo.nos.noaa.gov/products/data/
elmr, and scan through the data for estuaries that you think 
may be suitable to get an idea of the species for which data are 
available. You may want to include one or two invertebrate 
species as well as fishes for each student group. For example, 
the following species are among those that could be compared 
in the Winyah Bay and Chesapeake Bay estuaries:

Alewife
American Eel
American Shad
Atlantic Croaker
Atlantic Menhaden
Atlantic Sturgeon
Bay Anchovy
Black Drum
Blue Crab
Brown Shrimp
Daggerblade Grass Shrimp
Eastern Oyster
Pinfish
Quahog
Red Drum
Spot

http://biogeo.nos.noaa.gov/products/data/elmr
http://biogeo.nos.noaa.gov/products/data/elmr
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Summer Flounder
Weakfish

2. 
Discuss the importance of living estuarine resources and some 
of the sources of stress that may threaten these resources. 
Students should realize that stress may result from natural pro-
cesses (such as storms, drought, or disease) as well as human 
activity such as coastal development, heavy industry, or oil 
spills. Be sure students understand that many organisms are 
adapted to withstand natural stresses, but may not be able to 
tolerate these stresses if they are also exposed to stress from 
human activities. Discuss the importance of being able to rec-
ognize change in populations of estuarine organisms and of 
being able to separate normal variability from unusual change. 
Both of these capabilities depend upon having “baseline” 
information about species of interest that can be compared with 
new information from periodic monitoring of these species.

Tell students that their assignment is to prepare a written 
report in which they summarize baseline information about 
selected species in two (or more) estuaries, and use this infor-
mation to draw inferences about the ecology of these species. 
Be sure students understand that the primary purpose of the 
ELMR Database is to provide a reference point for each estu-
ary that can be used to analyze future monitoring data from the 
SAME estuary. These reference data, though, can also provide 
information about variations in the life history of individual 
species in different estuaries.

3. 
Assign each student group at least three species in at least two 
different estuaries, and provide each group with a copy of the 
“ELMR Database Worksheet.” 

4. 
Have each student group present an oral summary of their 
analyses and inferences based on steps 7 and 8 on the 
Worksheet. Students should understand that a defining charac-
teristic of all estuaries is variable salinity, and that this charac-
teristic can offer advantages to species that can tolerate a range 
of salinities. At a minimum, student analyses should accurate-
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ly summarize abundance data for each of the five life stages, as 
well as the salinity ranges in which these stages were found. 
Inferences should include ideas about how these data may 
reflect reproductive strategies.

In a discussion of the Winyah Bay alewife data, for example, 
students should recognize that this species spawns through-
out the spring, so eggs and spawning adults are most com-
mon during March, April, and May. As the eggs develop, lar-
vae appear and are abundant through June. Juveniles appear 
somewhat later and remain abundant through November. 
Students may infer that eggs and larvae do not tolerate salini-
ties above 0.5 ppt, or may hypothesize that these life stages 
inhabit low-salinity waters to avoid predators that require 
higher salinities. The latter hypothesis is supported by the 
observation that spawning adults were found only in waters 
with salinity of 0 - 0.5 ppt, even though non-spawning adults 
were equally abundant in all three salinity ranges. In addition, 
juveniles appear to expand their salinity range as they grow 
older. The absence of any life stages during December through 
February may suggest that alewife use estuaries primarily as 
spawning and nursery areas, and live in farther from shore 
during the winter months. 

Severe storms or prolonged droughts may alter the salinity 
distribution within an estuary. Reductions in freshwater flow 
caused by droughts or seawater driven into estuaries by storm 
winds could both cause higher-than-normal salinities. This 
could be fatal for life stages of species that are confined to low 
salinity waters (such as the eggs, larvae, and young juveniles 
of alewife).

These patterns will vary, depending upon the estuary and 
species. White shrimp adults and juveniles, for example, are 
found in the Winyah Bay estuary throughout the year, though 
larvae of this species are only present from May through 
September. No eggs or spawning adults of this species were 
observed in any month, which might mean that spawning 
occurs elsewhere or more likely that these stages were missed 
by the sampling program that produced the data.
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The Bridge Connection 
http://www.vims.edu/bridge/ – In the “Site Navigation” menu on 
the left, click on “Ocean Science Topics,” then “Habitats,” then 
“Estuary” for links to resources about estuaries.

The Me Connection 
Have students write a brief essay describing a monitoring pro-
gram for an ecosystem in their own community that is person-
ally important. Essays should include an explanation of why 
this system is important (reasons could include ecological, 
economic, or aesthetic values, or a combination of these), what 
factors would be monitored, and how frequently monitoring 
should be done. 

Extensions 
Visit http://www.epa.gov/owow/estuaries/monitor/ for an online 
manual for Volunteer Estuary Monitoring, as well as informa-
tion on the ecology of estuaries and how they are threatened.

Resources 
http://www.epa.gov/owow/estuaries/kids/ – Games and activities 

about estuaries produced through the National Estuary 
Program

http://www.onr.navy.mil/focus/ocean/ – Oceanography site from the 
Office of Naval Research including online quizzes and 
activities. See the “Habitats” section for information and 
activities about estuaries. 

http://www.ncnerr.org/education/estnet/index.html – “Estuary-Net 
Project;” an online project for grades 9-12 to help solve 
non-point source pollution problems in estuaries and 
their watersheds

National Science Education Standards 
Content Standard A:  Science as Inquiry

• Abilities necessary to do scientific inquiry
• Understandings about scientific inquiry

Content Standard C:  Life Science
• Interdependence of organisms
• Behavior of organisms

http://www.vims.edu/bridge/
http://www.epa.gov/owow/estuaries/monitor/
http://www.epa.gov/owow/estuaries/kids/
http://www.onr.navy.mil/focus/ocean/
http://www.ncnerr.org/education/estnet/index.html
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Content Standard E:  Science and Technology 
• Abilities of technological design
• Understandings about science and technology

Content Standard F:  Science in Personal and Social 
Perspectives 

• Personal and community health
• Natural resources
• Environmental quality
• Natural and human-induced hazards
• Science and technology in local, national, and global chal-

lenges
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ESTUARY REVIEW

ELMR Database Worksheet

The Estuarine Living Marine Resources (ELMR) Data Base 
includes data on selected fish and invertebrate species in 122 
estuaries along the coastlines of the United States. Each estu-
ary is divided into one of five salinity zones. In each zone, data 
are provided for the relative abundance of five life stages for 
each of the selected species that are present. These life stages 
are adults, eggs, juveniles, larvae, and spawning adults. Data 
for each life stage for each species are provided for each of 
twelve months. Relative abundance is represented by a scale 
from 0 to 5:
 0 = not present
 2 = rare
 3 = common
 4 = abundant
 5 = highly abundant
An entry of “.” means that no data are available.

Your assignment is to compare data for certain species in two 
or more estuaries assigned by your teacher. For each assigned 
species, you should find out:

• In what months is each of the five life stages present, and 
in what months is each stage most abundant?

• In what salinity range is each of the five life stages found 
during the months that it is most abundant?

The easiest way to make these comparisons is to download 
the necessary data, and import these data into a spreadsheet 
program that will allow you to sort, summarize, and graph 
them. Here’s how to retrieve ELMR data and import them into 
Microsoft Excel® using the Winyah Bay estuary as an example:

1. Open the ELMR Database at http://biogeo.nos.noaa.gov/products/
data/elmr/.

2. Select the “Region” that includes the estuary you are inter-
ested in (SOUTHEAST), then the appropriate estuary name 
in the “Estuary” window (WINYAH BAY). You can confine 

http://biogeo.nos.noaa.gov/products/data/elmr/
http://biogeo.nos.noaa.gov/products/data/elmr/
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your search to specific Species, Life Stages, and Salinity 
Zones, or just leave “ALL” selected in these windows. For 
now, leave “ALL” selected. Click the “Search” button.

3. Click the “Tab Delimited” button, then “Download Format” 
button. Give the file a name, then save it onto your hard 
drive.

4. Open the downloaded data file in Microsoft Excel®. You 
will get the Text Import Wizard. 
Step 1. Select “Delimited,” “Start Import at Row: 1,” and 

the operating system you are using next to “File Origin.” 
Click “Next.”

Step 2. Select “Delimiters: Tab” and “Text Qualifier: “. ” 
Click “Next.”

Step 3. Click the “General” button under “Column Data 
Format.” Click “Finish.”

5. You now have a spreadsheet with all of the data for Winyah 
Bay. Now you need to make a few adjustments to this 
spreadsheet to make it easier to analyze:
a. Highlight rows 1 through 7, which contain information 

about the data file. Click “Delete” under the “Edit” menu.
b. Highlight columns B and C. Under the “Format” menu, 

select “Column” and then “Width.” Change the width of 
columns B and C to 20.

c. Highlight columns E through P. Under the “Format” 
menu, select “Column” and then “Width.” Change the 
width of columns E through P to 5.

e. Highlight all cells by clicking on the empty cell in the 
upper left corner. Under the “Data” menu click “Sort.” 
Check the box next to “Header Row” under “My list has.” 
Under “Sort By” select “Common Name.” Under “Then 
by” select “LifeStage.” Click “OK.”

6. Prepare data summary graphs for each of your assigned spe-
cies as follows:
a. Highlight all cells in columns C through P for all Life 

Stages of the species you are analyzing. For this example, 
suppose “Alewife” is one of your assigned species; then 
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you would highlight cells C2 through P16.
b. Click on the Chart Wizard icon. Select “Column” under 

“Chart type” and the upper left icon under “Chart sub-
type.” Click “Next.”

c. Click the button next to “Rows” under “Series in.” 
Click the “Series” tab, and remove all life stages except 
“Adults” and “Spawning.” Click “Next.” Click “Next.”

d. Click the “Titles” tab. Enter a title for your chart (such as 
“Alewife Adults and Spawning”). Enter “Month” in the 
“Category (X) axis:” box and “Abundance” in the “Value 
(Y) axis:” box. Click “Next.”

e. Click the button next to “As new sheet” and enter the 
name that you want to appear on the tab for your chart in 
the spreadsheet workspace. Click “Finish.” You now have 
a column chart that shows the relative abundance of ale-
wife adults and spawning adults in each salinity zone for 
each month.

f. If you want to print your chart and do not have a color 
printer, you may want to change the column fills to black 
and white patterns. To do this, double click on one of 
the columns on your chart. The “Format Data Series” dia-
logue box will open. Click on the “Patterns” tab, then 
the “Fill Effects” button under “Area.” Click the “Pattern” 
tab. Select black in the window under “Foreground:” and 
white in the window under “Background:” Windows con-
taining the various pattern options should appear under 
“Pattern:” Select the pattern you want, be sure it looks 
OK in the “Sample” box, then click “OK.” Click “OK” in 
the  “Format Data Series” dialogue box. The column on 
your chart should now contain a black-and-white fill pat-
tern. Repeat these steps for the other columns.

g. Repeat steps a. and b. Click the button next to “Rows” 
under “Series in.” Click the “Series” tab, and remove 
“Adults” and “Spawning” life stages. Click “Next,” and 
repeat steps d. and e. You now have a second column 
chart that shows the relative abundance of alewife eggs, 
larvae, and juveniles in each salinity zone for each month. 
Adjust the column fills if necessary.

7. Use your chart to discover:
a. When are spawning adults most abundant?
b. When are eggs most abundant?
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c. When are larvae most abundant?
d. When are juveniles most abundant?
e. When are adults most abundant?
f. Are any of these life stages more abundant in certain 

salinity zones?

For the Winyah Bay alewife example, adults and spawning 
adults are most abundant in March, April and May; eggs 
are most abundant in March, April and May; larvae are 
most abundant in March, April, May and June; juveniles 
are abundant from April through November. Notice that 
all life stages of alewife are absent from December through 
February. Different life stages of alewife appear to have 
different salinity preferences. Alewife eggs and larvae are 
found only in salinities of 0 - 0.5 ppt. Juveniles are also 
confined to this salinity zone during April, May, June, 
and July; but are found in the 0.5 - 25 ppt salinity zone 
between August and November, and in the >25 ppt zone 
between September and November. Alewife adults are 
found in all three salinity zones, but spawning adults are 
only found in the 0 - 0.5 ppt zone.

8. Discuss possible reasons for seasonal variations in the 
abundance of different life stages. What effect could severe 
storms or prolonged drought have on your assigned       
species?


